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Puji dan syukur atas segala rahmat yang diberikan oleh SWT yang mana Penulis masih 
diberikan kesempatan untuk mempersembahkan sebuah modul atau buku panduan 
yang insya Allah dapat berguna bagi pembaca umumnya dan para siswa yang sedang 
belajar teknik dari program CorelDraw versi X7. Modul ini disusun untuk 
mempermudah bagi para siswa yang sedang mempelajari teknik-teknik dari program 
design Corel Draw versi X7 

Modul ini disusun berdasarkan dari beberapa sumber dan tentukan dari pengalaman 
design penulis sendiri yang sudah terjun di dunia design dan percetakan sejak tahun 
1998 dan masih berlangsung sampai sekarang. 

Modul ini berisikan pengenalan program bagi siswa level pemula, teknik-teknik 
pengoperasian dari Coreldraw yang di sertai dengan tip dan triknya serta juga berisikan 
latihan latihan untuk memperlancar pengajaran program coreldraw versi X7.  

Semoga modul dapat bermanfaat dan penulis mohon maaf apabila masih ada 
kekurangan – kekurangan dan penulisan dan materi dalam modul ini mengingat teknik 
dan pengoperasian program ini sangat banyak dan tergantung dari objek design yang 
akan dikerjakan dan insya Allah dengan menguasai modul ini para siswa dapat 
melakukan design yang lebih berkualitas dalam waktu singkat dengan menggunakan 
program Coreldraw versi X7.  

 

 

Penulis. 

  



BAB 1 

PENGENALAN COREL DRAW VERSI X7 

 

Apa Itu CorelDRAW? 
CorelDRAW – The Popular Drawing Software 
CorelDRAW adalah sebuah drawing software yang sangat populer. Sebuah software yang serba 
guna dan dimanfaatkan oleh para desainer dari berbagai aliran: senimurni, desain logo, desain 
ikon dan karakter, desain poster, brosur, kartu nama,cover buku dan sebagainya. Digemari oleh 
desainer cetak karena memiliki paletwarna yang mendekati warna yang dihasilkan oleh mesin 
cetak, meskipun demikian CorelDRAW tidaklah cocok digunakan untuk layout isi buku. Pertama 
kali muncul pada tahun 1987, versi terakhir yang dirilis adalah X7 (17). Popularitas dan 
penggunaannya yang begitu luas membuat software lain yang sejenis, sedikit banyak kemudian 
mengikuti tampilan dan cara penggunaannya, termasuk drawing software yang tidak berbayar 
(open source). 
 

 
Drawing dan Painting, Apa Bedanya? 
 
Apa saja software grafis yang anda kenal? Jika anda menyebut Adobe Photoshop, ia termasuk 
painting software. Apa beda drawing dan painting kalau begitu? Painting berarti bahwa ketika 
anda menambahkan sesuatu – apakah itu titik, garis, bangun, coretan dan sebagainya – ke atas 
bidang gambar, maka anda melakukan hal yang sama dengan mencorat-coret sebuah kertas: 
anda mengubah warna bidang gambar tersebut, sehingga coretan yang anda buat tidak dapat 
digeser atau diubah kecuali dihapus. Pada painting, manipulasi individual terhadap coretan 
dicapai dengan sistem layering: seolah-olah anda memiliki selembar kertas putih di dasar dan 
berlapis-lapis kertas transparan di atasnya: coretan pada lapis ke 15 dapat anda hapus tanpa 
merusak coretan lain di lapis ke 14. Drawing berarti bahwa apa yang anda tambahkan ke bidang 
gambar sebenarnya adalah sebuah objek. Seperti menaruh pin, penggaris, dan busur di atas 
selembar kertas. Benda-benda tersebut tidak pernah menyatu dengan kertasnya, sehingga 
bebas untuk dimanipulasi, misalnya digeser. Setiap objek drawing merupakan hasil 
penggambaran secara matematis dari informasi komponen grafis objek yang tersimpan. Ukuran 
file citra hasil painting akan membesar seiring dengan ukuran bidang gambar dan jumlah 
layernya, sedangkan ukuran file gambar hasil drawing tergantung pada banyaknya objek di 
dalamnya. Citra painting menyimpan hasil akhir coretan-coretan anda berupa sebuah lukisan 
utuh (dikenal juga sebagai bitmap); gambar drawing menyimpan koordinat titik, jenis objek dan 
manipulasinya saja (dikenal juga sebagai vector), sehingga perlu rendering (proses 
penggambaran) setiap kali kita ingin melihat hasilnya. 

 
 
 

  



 
Membuka CorelDRAW 
 
CorelDRAW bukanlah sesuatu yang langsung ada di komputer anda, ketika anda baru saja 
membelinya misalnya, atau setelah anda melakukan instalasi sebuah sistem operasi. Tentu 
anda harus terlebih dahulu membeli software ini dan melakukan instalasi sebelum anda mulai 
menggunakannya. CorelDRAW tersedia dalam paket bernama Corel Graphics Suite bersama 
beberapa software grafis lain dari Corel yang saling melengkapi. Ukuran instalasinya antara 
100-300 megabyte untuk seluruh paket tersebut. Corel Graphics Suite tersedia untuk sistem 
operasi Windows dan Macintosh. Jika CorelDRAW telah terinstal, sangat mudah untuk 
membukanya, tinggal menamukan lokasi grup software aplikasi pada computer anda. Contoh 
untuk Windows adalah klik tombol ‘Start’ _ ‘All Programs’ _ ‘CorelDRAW Graphics Suite X7’ _ 
‘CorelDRAW X7’. Bagaimana jika versi CorelDRAW yang dimiliki berbeda? Temukan saja bagian 
menu yang memuat kata Corel, kemudian cari shortcut untuk CorelDRAW di sana.  
 
Setelah memberikan perintah untuk membuka CorelDRAW, mungkin saja akan muncul jendela 
dengan pertanyaan atau pilihan, klik saja ‘New’, dan akan muncul antarmuka utama 
CorelDRAW. CorelDRAW tidak mengalami perubahan radikal dari satu versi ke versi berikutnya, 
sehingga informasi dalam modul ini masih dapat anda gunakan. Perbedaan yang ada adalah 
kemampuan baru yang ditambahkan setiap kenaikan versi, yang biasanya ditunjukkan oleh 
adanya tool baru pada toolbar atau menu baru, sehingga pada versi yang lebih lama dari X7, 
beberapa bagian antarmuka belum ada.  
 

 
 
 



Bagian-bagian antarmuka CorelDRAW (nomor menunjuk pada ilustrasi gambar): 
1.  Title Bar 
2.  Menu Bar 

Kumpulan menu yang digunakan untuk mengakses seluruh fungsi-fungsi yang ada pada 
CorelDraw, termasuk membuka – menyimpan file, efek-efek, dan sebagainya. 

3.  Standard Toolbar 
Kumpulan icon yang berfungsi untuk mengakses menu-menu umum yang paling sering 
dipakai. Berikut isi standard toolbar: 

 
 
4.  Property Bar 

Berfungsi menampilkan pilihan properti dari sebuah fungsi toolbox yang tengah dipakai. 
Pada kondisi default (tool yang terpilih adalah pick tool – panah putih, maka property bar 
akan berisi ukuran kertas bidang gambar, orientasi kertas, unit yang digunakan, dan 
sebagainya. Property bar akan selalu berubah tergantung dari tool yang kita pilih di toolbox. 
 

 
 



5.  Ruler Bar 
 
6.  Toolbox 

Berisi pilihan tool dan mode menggambar. Klik pada sebuah ikon tool untuk 
menggunakannya, maka tombol ikon akan tampak seperti ditekan, dan tool tersebut siap 
kita gunakan pada bidang gambar. Kadang juga terdapat subtool yang dapat dimunculkan 
dengan menekan agak lama pada sebuah icon tool, kemudian klik pada sub tool yang 
tersedia. Isi Toolbox ditunjukkan pada halaman berikutnya  
 
 

 
 
7.  Bidang Kerja 
 
8.  Bidang Gambar 

Luasan bidang gambar dengan ukuran kertas tertentu yang dapat kita gunakan untuk 
mendesain gambar. Apa yang berada di luar tepi bidang gambar tidak akan ikut tercetak saat 
diprint. 
 

9.  Palet Warna 
Digunakan untuk memilih warna yang akan kita pakai untuk mewarnai sebuah objek gambar. 
Klik kiri pada palet akan mengeset warna isian (fill) suatu objek, dan klik kanan pada palet 
akan mengeset warna tepi dan garis (line). 



 
10. Penunjuk Halaman 
 

 
 
11. Status Bar 

Menunjukkan beberapa status penting dan event yang sedang terjadi, juga pada bagian 
kanan menunjukkan warna fill dan line sebuah objek. 
 

12. Object Properties 
Menampilkan setting yang dapat dipilih dari sebuah objek. Biasanya yang terdapat di sini 
adalah warna fill, warna garis, dan sebagainya untuk sebuah objek tertentu saja. 

 
 
 

 



Tool Untuk Menggambar 
Anda membutuhkan beberapa peralatan dasar untuk memudahkan anda menggambar. 
Peralatan atau tool ini tersedia pada Toolbox di sebelah kiri antarmuka, dan secara sengaja 
dikelompokkan pada bagian atas untuk mempermudah penggunanya mengingat dan 
menjangkaunya. Tool harus diklik terlebih dahulu untuk menggunakannya. Tool dasar ini 
diantaranya adalah: 
 
 

Pick Tool 
Memilih dan mengaktifkan obyek untuk melakukan manipulasi objek. Misalnya scaling, 
rotating, skewing, resizing. 
Shape Tools 
1. Shape Tool : Melakukan proses editing node pada shape (komponen garis dari obyek). 
2. Smudge Tool : Menggosok obyek sehingga merubah bentuk obyek yang digosok tersebut. 
3. Roughen Tool : Memberikan efek distorsi pada obyek. 
4. Transform Tool : Merotasi, membesarkan, mengecilkan, skewing image secara bebas. 
 

 
Crop Tools 
1. Crop Tool : Digunakan untuk menghapus objek diluar seleksi. 
 
2. Knife Tool : Pisau yang berfungsi untuk memotong obyek. Cara kerjanya persis seperti 

menggunakan pisau biasa. 



3. Eraser Tool : Menghapus bagian tertentu dari obyek. 
 
4. Virtual Segment delete tool : Menghapus segmen secara virtual  
 
Zoom Tools 
1. Zoom Tool : Membesarkan atau mengecilkan tampilan area kerja di monitor. 
 
2. Hand Tool : Menggeser area kerja ke posisi tertentu. 

 

  



 

Mulai Menggambar 

 
 
Mengatur Ukuran Bidang Gambar 
Karena dirancang untuk desain kreatif – termasuk desain cetak, maka CorelDRAW 
menyediakan bermacam-macam ukuran kertas secara default untuk membantu Anda 
memilih secara cepat ukuran yang diinginkan. Hampir segala jenis ukuran kertas standar 
yang populer dapat anda temukan di sini: Letter, A4, F4, B4, Business Card, Hagaki dan 
sebagainya. 
 
Pengaturan tambahan meliputi orientasi kertas, satuan ukuran yang akan digunakan dan 
lain-lain. Klik Menu Tools _ Options _ Document _ Page _ Size untuk memunculkan jendela 
pengaturan ukuran bidang gambar yang ditunjukkan pada halaman berikutnya. Alternatif 
lain adalah ketika tool dalam posisi ‘Pick Tool’, ubah ukuran kertas yang ada pada Property 
Bar, apakah Letter, A4 atau sebagainya, atau kita juga bisa mendefinisikan sendiri ukuran 
yang kita mau, misalnya 3 x 4 inchi, atau 30 x 30 cm, pada boks di sebelah kanan ukuran 
kertas, sekaligus pilih orientasi kertas, apakah portrait (tegak) atau landscape (tidur). 
 

 



Menambahkan Objek 

Pada bagian awal dijelaskan bahwa CorelDRAW adalah drawing software. Semua yang 
terletak di atas bidang gambar adalah objek. Artinya, apapun yang pernah anda lihat berada 
di atas bidang gambar, baik itu titik, garis, bangun, citra (image), teks dan lain-lain, yang 
meskipun seolah-olah membentuk sebuah kesatuan komposisi, sebenarnya adalah entitas-
entitas terpisah yang saling bebas satu sama lain. 
 
Objek apa saja yang dapat ditambahkan ke dalam bidang gambar? 
Ada berbagai pilihan objek yang disediakan pada bagian tengah Toolbox. Seluruhnya adalah 
objek geometris – karena dibuat secara matematis, tetapi objek-objek ini jika 
dikombinasikan dapat menghasilkan gambar yang menarik. 

 

 
Curve Tools 
1. Freehand Tool : Membuat obyek berupa garis bebas. 
 
2. Bezier Tool : Membuat obyek garis dengan menentukan banyaknya node. 

 
3. Artistic Media Tool : Membuat obyek garis dengan berbagai bentuk yang artistik. 

 
4. Pen Tool : Membuat obyek kombinasi antara garis lurus dan garis lengkung secara 

langsung. 
 



5. Polyline Tool : Membuat obyek kombinasi garis lurus dan freehand secara langsung. 
 
6. 3-Point Tool : Membuat obyek garis dengan kurva 3 point. 
 
7. Connector Tool : Membuat obyek garis konektor secara interaktif 
 
8. Dimension Tool : Membuat obyek garis ukuran pada suatu obyek yang kita buat. 
 
Smart Tools 
1. Smart Fill : Untuk mewarna objek dan garis secara bersamaan sesuai dengan pengaturan. 
 
2. Smart Drawing : Membuat obyek garis secara bebas seperti freehand tool, namun dengan 

hasil yang lebih bagus. 
 
Rectangle Tools 
1. Rectangle Tool : Membuat obyek persegi panjang atau bujur sangkar. 
 
2. 3-Point Rectangle Tool : Membuat obyek persegi panjang atau bujur sangkar dengan 

kemiringan tertentu. 
 
Ellipse Tools 
1. Ellipse Tool : Membuat obyek lingkaran atau elips. 
 
2. 3-Point Ellipse Tool : Membuat obyek lingkaran atau elips dengan kemiringan tertentu. 
 
Object Tools 
 



 
 
1. Polygon Tool : Membuat obyek segi banyak. 
 
2. Star Tool : Membuat obyek-obyek bintang. 

 
3. Complex Star Tool : Membuat obyek-obyek bintang sudut banyak. 
 
4. Graph Paper : Membuat obyek menyerupai tabel. 
 
5. Spiral Tool : Membuat obyek spiral. 
 
6. Text Tool : Membuat obyek teks. 



 
7. Table Tool : Membuat tabel. 
 
Perfect Shape Tools 
 
1. Basic Shapes Tool : Membuat obyek-obyek dasar. 
 
2. Arrow Shapes Tool : Membuat obyek-obyek anak panah. 
 
3. Flowchart Shapes Tool : Membuat obyek-obyek flowchart. 
 
4. Banner Shapes Tool : Membuat objek-objek banner. 
 
5. Callout Shapes Tool : Membuat obyek-obyek callout (objek isi teks pada komik). 
 
Eyedropper Tools 
1. Eyedropper tool : Mengambil sampel warna dari suatu obyek. 
 
2. Paintbucket tool : Memberikan warna tertentu pada suatu obyek. 
 
Bagaimana cara menambahkan objek? 
                                                                                                                                                                                                                                                                                         
Contoh berikut akan menambahkan objek berupa segi empat dan lingkaran. Untuk membuat 
segi empat, klik ‘Rectangle Tool’ pada Toolbox, klik pada bidang gambar, kemudian tarik 
sesuai ukuran segi empat yang diinginkan dan selamat, sebuah segi empat telah 
ditambahkan pada bidang gambar anda! Lakukan cara yang sama untuk menambahkan 
sebuah lingkaran, tetapi sebelumnya klik pada ‘Ellipse Tool’ sebelum anda mulai melakukan 
klik dan tarik pada bidang gambar. Setiap bentuk objek sebenarnya memiliki shortcut tombol 
keyboard masing-masing untuk mempercepat proses desain. Temukan beberapa 
diantaranya melalui eksperimen, dan cobalah membuat objek-objek yang lainnya! 
 
 
 
Catatan ketika menambahkan objek teks 
Jika anda ingin menambahkan teks tanpa batas segi empat – misalkan kalimat slogan atau 
judul, klik ‘Text Tool’ kemudian cukup sekali klik pada bidang gambar, dan ketikkan teks yang 
anda inginkan. Jika anda melakukan dengan cara yang sama seperti contoh di atas (klik dan 
tarik) saat menambahkan objek teks, maka akan tercipta sebuah batas segi empat yang 
menjadi tempat menuliskan teks anda. Batas ini berfungsi seperti batas kolom pada majalah. 
 
 
 
 
 



Bagaimana cara mengubah garis dan isian objek? 
Lakukan eksperimen pribadi, dan temukan bagaimana anda dapat mengubah warna garis, 
ketebalan garis, pola garis, warna isian objek, pola isian objek, dan sebagainya. Temukan 
jawabannya pada suplemen modul ini, tetapi berusahalah untuk menemukannya sendiri 
terlebih dahulu! 

 

Menambahkan Objek Gambar Berformat Lain 

Tidak hanya objek asli dari CorelDRAW yang dapat kita taruh di atas bidang gambar. 
Seandainya anda memiliki citra atau gambar yang dibuat dengan software grafis lainnya, 
objek tersebut dapat dimasukkan pula ke dalam bidang gambar, jika format objek tersebut 
didukung oleh CorelDRAW. Format gambar lain yang didukung misalnya adalah EPS 
(Encapsulated PostScript), AI (Adobe Illustrator), SVG (Scalable Vector Graphics – format 
gambar terbuka), serta format-format citra umum seperti BMP (bitmap), JPG, GIF, PNG 
(Portable Network Graphics – format citra terbuka) dan sebagainya. Caranya adalah sebagai 
berikut: 
a.  Klik pada menu ‘File _ Import’, atau bisa juga dengan menekan ‘Ctrl + I’ pada keyboard. 
b. Muncul kotak dialog ‘Import’ untuk memilih gambar, pilih gambar yang dikehendaki, 

kemudian klik tombol Import 
c. Muncul placeholder untuk meletakkan gambar di bidang gambar, gerakkan mouse ke 

tempat yang dikehendaki, kemudian klik untuk menempatkan gambar tersebut. 
d.  Objek selesai diimpor ke bidang gambar. Objek ini masih bisa digeser jika letaknya kurang 

pas dengan cara klik pada bagian objek yang bukan bagian tengahnya, kemudian tarik ke 
lokasi yang diinginkan. 

 
 
 
 
Memanipulasi Objek 
Kelebihan dari konsep objek adalah, bahwa sebuah objek tidak terikat dengan bidang 
gambarnya maupun objek yang lain, sehingga setiap objek bisa dimanipulasi secara bebas 
tanpa mempengaruhi yang lain. Manipulasi Dasar Objek 
 
1. Select (Memilih) 
Pilih tool Pick Tool yang berada pada urutan teratas toolbox, kemudian klik pada objek yang 
diinginkan. Untuk memilih lebih dari satu objek, sinari seluruh objek (melakukan klik dan 
tarik pada area sekitar objek-objek dimaksud) atau menekan tombol keyboard ‘Shift’ sambil 
melakukan klik pada masing-masing objek. 
 
2. Move (Memindah) 
Pilih objek yang diinginkan, kemudian pindahkan dengan cara melakukan klik dan tarik pada 
objek tersebut. Jika anda ingin menggeser beberapa objek sekaligus, pastikan ketika 
melakukan klik dan drag, kursor mouse diposisikan pada salah satu objek tersebut. 



 
 
 
3. Resize (Memperbesar/Memperkecil) 
Pilih objek yang diinginkan, kemudian klik dan tarik kotak berwarna hitam di pojok-pojok 
atau kiri-kanan-atas-bawah objek untuk merubah ukuran objek. Jika Anda menginginkan 
objek membesar dan mengecil sesuai porosnya, tekan terlebih dahulu dan tahan tombol 
keyboard ‘Shift’ selama melakukan klik dan tarik. Alternatif lain untuk melakukan resize 
adalah menggunakan ukuran persen yang terdapat pada Property Bar. Persen ini berlaku 
untuk panjang dan lebar objek. Jika menggunakan property bar, anda harus mengetikkan 
angka yang diinginkan, kemudian tekan tombol keyboard ‘Enter’.   



 
 
 
4. Rotate (Memutar) 
Pilih objek yang diinginkan, lalu klik sekali lagi pada sembarang bagian objek untuk 
menjadikan mode rotate, di mana tanda hitam di pojok-pojok akan berubah menjadi panah 
melingkar. Klik dan tarik pada panah tersebut untuk memutar objek. Jika anda menginginkan 
objek berputar sesuai porosnya yang baru, Anda harus memindah poros-nya dengan cara 
klik dan tarik pada ikon poros. Alternatif rotasi yang lain adalah menggunakan fungsi rotasi 
yang ada pada Property Bar, dengan fungsi rotasi CCW (counter clockwise – melawan arah 
jarum jam). Jika menggunakan property bar, anda harus mengetikkan angka yang diinginkan, 
kemudian tekan tombol keyboard ‘Enter’. Setelah selesai melakukan rotasi, klik sekali lagi 
pada objek untuk mengembalikannya ke mode resize. 
 



 
5. Delete (Hapus) 
Pilih objek yang diinginkan, lalu tekan tombol ‘Del’ pada keyboard.  
Mengapa objek dapat dimanipulasi dengan mudah?  
Ditarik, dibalik, diputar, kok sepertinya luwes sekali? Objek yang terlihat di layar sebenarnya 
disimpan sebagai informasi komponen grafis saja, misalnya koordinat titik, garis, warna, dan 
rumus penyusun objek tersebut. Apa yang terlihat secara visual adalah hasil rendering atau 
penggambaran secara matematis dari komponen-komponen grafis objek tersebut. Dengan 
demikian manipulasi akan langsung diterapkan secara matematis terhadap komponen 
informasi yang dimanipulasi, misalnya letak sebuah titik, dan secara otomatis komponen lain 
akan menyesuaikan. Ukuran dan posisi objek tidak akan mempengaruhi besarnya informasi 
yang disimpan, tetapi banyaknya objek yang disimpan.  

 
 



Menyimpan dan Membuka Gambar 
Bekerja dengan banyak objek akan membuat memory komputer berkurang, dan bukan tidak 
mungkin nantinya anda akan bekerja dengan ratusan bahkan ribuan objek, yang – karena 
asyiknya – tidak terasa menghabiskan seluruh memory komputer dengan efek samping 
komputer berhenti atau mengeluarkan pesan kesalahan. Satu hal yang harus diketahui 
adalah jika hal ini terjadi, pada beberapa kasus CorelDRAW ikut berhenti dan gambar anda 
menjadi hilang. Seluruhnya? Ya, seluruhnya! Oleh karena itu jangan lupa untuk sering 
melakukan penyimpanan untuk mencegah hilangnya pekerjaan anda. Disarankan untuk 
melakukan save setiap 5 atau 10 menit sekali. 
 
Menyimpan Gambar 
Klik pada menu ‘File _ Save’, atau bisa juga dengan menekan ‘Ctrl + S’ pada keyboard, atau 
dengan mengklik ikon ‘Save’ (gambar disket) pada Standard Toolbar. Jika sebelumnya 
gambar belum pernah disimpan, akan muncul kotak dialog ‘Save Drawing’ yang menanyakan 
nama file. Ketikkan nama file sesuai keinginan anda, kemudian klik tombol ‘Save’. Untuk 
alasan kompatibilitas, anda dapat memilih format penyimpanan file gambar. Format default 
adalah CDR. Anda dapat juga memilih untuk menyimpan dalam format CDR versi-versi 
sebelumnya, agar file gambar anda dapat dibuka oleh CorelDRAW versi lama. Jendela 
penyimpanan ditunjukkan oleh gambar pada halaman berikutnya.  
 

 
 



 
Membuka File Gambar 
Untuk membuka kembali gambar, klik pada menu ‘File _ Open’, atau bisa juga dengan 
menekan ‘Ctrl + O’ pada keyboard, atau dengan mengklik ikon ‘Open’ (gambar folder 
berpanah keluar) pada Standard Toolbar. Akan muncul kotak dialog ‘Open Drawing’, pilih file 
yang diinginkan kemudian klik tombol ‘Open’.  
 
Menyimpan gambar yang mengandung objek teks. 
Jika anda memiliki objek teks pada gambar anda, kemungkinan ketika gambar tersebut 
dibuka di komputer lain, ada beberapa font yang tidak dimiliki komputer tersebut, sehingga 
font yang anda gunakan untuk menuliskan teks tidak akan dapat ditampilkan. Untuk 
menghindari hal ini, pilihlah objek-objek teks yang dibuat menggunakan font yang jarang 
ada, kemudian lakukan ‘Convert to Curve’. Objek teks anda akan menjadi kurva. Kekurangan 
dari cara ini adalah teks anda tidak dapat diedit kembali. Cara lain adalah dengan 
mencontreng pilihan ‘Embed Truetype Fonts’ saat melakukan penyimpanan pertama kali. 
Dengan cara kedua ini teks masih tetap dapat diedit, tetapi ukuran file akan menjadi lebih 
besar karena memuat pula seluruh font yang digunakan. 
 
Edit dua objek atau lebih 
Jika anda memiliki dua atau lebih objek curva yang perlu di edit dengan penggabungan atau 
melakukan potongan pada objek tersebut yang bersinggungan maka kita perlu kita gunakan 
combine tol bar  
 

 
Dalam  tool bar ini  juga terdapat tool lain yaitu ; 
 

1. Weld  yaitu mengcombine 1 atau lebih menjadi satu objek dengan satu fil dan satu 
outline 

2. Trim yaitu memotong sbagian dari satu objek oleh objek yang lain 
3. Intersect yaitu menghasilkan objek lain dari overleaping dua objek atau lebih 
4. Simplify  yaitu melakkukan trim pada objek dan hasilnya menjadi bagi dari objek itu 
5. Front minus back yaitu objek yang di depan di kurangi oleh objek yang di belakang 
6. Back minus front yaitu objek belakang di kurangi objek depan 
7. Create boundary yaitu membuat satu objek dari keliling dua objek atau lebih 

 
 
 
 



BAB II 
LATIHAN 1 
 
 
MEMBUAT STEMPEL 

Nah Kali ini saya akan memberikan tips bagaimana membuat desain stempel 
Langkah pertama buat objek berbentuk lingkaran dengan diameter 35 mm 
 

 
 
Copy lingkaran tersebut, kemudian ubah langsung diameternya menjadi 23 mm 
 

 
 
Nah, Sekarang buat guide untuk teksnya, copy lagi bentuk lingkaran yang kecil dan rubah 
diameternya menjadi 25 mm, beri warna merah, caranya klik kanan pada warna merah pada 
color palette  

http://www.ilmugrafis.com/coreldraw_free.php?page=membuat-desain-stempel


 
 
Kini kita hanya butuh 3/4 dari seluruh lingkaran merah, aktifkan lingkaran merah kemudian 
pada property bar pilih bentuk Arc  

 
 
Gunakan Shape Tool untuk menarik sudut dari lingkaran seperti gambar disamping 

 
 
Buat satu guide untuk tulisan dibawah, dengan mengcopy lingkaran merah, kemudian dengan 
shape tool tarik sudutnya seperti berikut: 



 
 
Sekarang Ketik Teks:  Pt. GLOBAL INNOVATION RESOURCES, Font yang saya gunakan type: 
IMPACT: Size: 12 
Aktifkan teks tersebut dan klik menu TEXT >> Fit Text To Path , Lalu klik lingkaran merah 
atas 
 
 

 
 
Hilangkan warna merah pada lingkaran guide, dengan cara aktifkan / klik gluide tersebut  
 
 
Beri tanda bintang diantara teks, atau pertebal beberapa point 
 
Hasilnya: 

 



 
Stempel logo 

 

1. Pertama Buka Corel Lalu buat Stamplenya(saya yakin pasti temen2 udah bisa...) Seperti 

gambar dibawah ini 

 
 

 

 

Saya wajibkan semua bidang/object pada stampel tersebut  haruslah menajdi satu bidang, yg 

saya maksud disini bukan Group tapi Weld.  

2. Langkah kedua adalah membuat coretan tanpa arah menggunakan Freehand Tool seperti 

gambar dibawah ini 

 



 

pada stampel kita tadi lalu Trim-kan setelah itu wujud dari stampel kita tadi akan seperti ini 

 

 
 

 

5. Lalu jadikan bitmap (Bitmaps >> Convert To Bitmap) 

 

 
Jangan lupa rendahkan resolusinya, 300 dpi mungkin dan jangan sampai lupa mengklik 

Transparent Background. 

 

6. Atur posisinya dan jadilah stampel kita... seperti ini... 

 



 
 

Memang hasilnya tidak maksimal, karena saya hanya mencontohkan saja, mungkin teman-

teman nanti bisa lebih maksimal dan bagus..  

  

TUGAS 

BUATLAH  STEMPEL  DENGAN MENGGUNAKAN 2 ATAU LEBIH WARNA 

  



 

BAB 2 

Sessi 2 

LATIHAN II   

 

BER MAIN DENGAN TEKS 

 

Perlu diingat bahwa CorelDRAW adalah program yang diunggulkan dalam memproduksi 

vector graphic dan semua font adalah vector graphic jadi dengan mudah kita bisa menggubah 

bentuk-bentuk font dalam corel, jika kita menggunakan Font(untuk diubah) gunakanlah yang 

simpel jangan terlalu rumit seperti el&font gohtic! Karena memperberat kinerja dari corel itu 

sendiri. 

 

Ditekankan disini, modul ini untuk memberikan pengetahuan pada anda bagaimana cara 

mengubah Font dari bentuk normal menjadi abnormal jadi bukan hasil dari Modul ini yang 

saya tekankan... baiklah tidak perlu panjang lebar omongan basi saya... langsung saja kita 

mulai 

 

1. First Step seperti biasanya Ctrl+N 

 

2. Buat atau tulis kata sesuka hati dan ubah font-nya seperti gambar dibawah  ini  

 
(Narsis dikit) Sengaja digunakan font GRAFFPITY / GRAFF___ karena terlihat rumit tapi 

sebenarnya simpel 

 

 

3. Lalu pisahkan semua font(Break Artistic Text) dengan menekan Ctrl+K pada keyboard 

http://www.ilmugrafis.com/
http://www.ilmugrafis.com/fonts/graffpity.zip


 
 

4. Lalu pisahkan semua font(Break Artistic Text) dengan menekan Ctrl+K pada keyboard 

Sampai kita bisa mewarnainya dengan warna2 berbeda, warna diatas tidak ada pengaruhnya 

terhadap apa yang kita kerjakan hanya untuk membantu saya menerangkan. Setelah itu seleksi 

semua huruf dan Convert To Curve atau Ctrl+Q(saya akan sering menggunakan Shortcut 

disetiap modul saya, maka dari itu dimohon untuk membaca penjelasan tentang shortcut keys 

corel). 

5. Setelah itu ubahlah ukuran Font atau letaknya, font paling depan dan belakang usahakan 

sama agar tidak terlalu mencolok, lebih spesifiknya ada dalam gambar dibawah (akhirnya 

punya kata laen...) 

 
 

5. Setelah itu mari kita ubah bentuk font satu per satu, kita mulai dari huruf pertama, klik 

Shape Tool lalu klik pada font dan akan terlihat node-node pada outline font tadi, jika harus 

ditampilkan gambarnya adalah sebagai berikut 

 
Delete semua Node pada object ditengah huruf(gambar anak panah) sehingga hilang 

objectnya seperti pada gambar dibawah ini(lagi....) 



 
lakukan langkah diatas pada semua object ditengah-tengah huruf tadi sampai seperti ini 

 
 

6. Kita potong bagian-bagian yang dirasa tidak penting, langkahnya sebagai berikut : 

 
Klik Beizer Tool untuk membuat object seperti gambar diatas, lalu tekan Shift dan klik pada 

huruf N lalu klik Trim dan terpotonglah huruf N tadi seperti gambar dibawah ini 



 
Dan balik huruf N tadi, itu tadi cara memotong yang susah, lebih mudah dengan shape tool 

menurut saya, setelah itu kita akan membangun satu font dari potongan font lain, misalkan 

potongan huruf V untuk ditambahkan pada huruf N, cara memotong sudah kita pelajari jadi 

langsung saja potong huruf V seperti gambar dibawah ini 

 
Kita pun bisa memperpanjang object merah itu dengan Shape Tool, caranya seleksi Node 

yang diperlukan untuk memperpanjag, lihat gambar dibawah 



 
Setelah itu(lagi) tekan Space Bar agar kembali ke Pick Tool, lalu klik object merah dan lalu 

tekan Shit+klik huruf N lalu klik Weld 

 

7. Langkah-langkah diatas dirasa cukup untuk mengubah bentuk Font, tapi akan saya teruskan 

modul ini, tambahkan lagi potongan huruf V dari sisi yang lain pada huruf R 

 
Langkahnya seperti pada huruf N tadi, lalu kita panjangkan huruf Y dengan Shape Tool lagi 



 
Kita bisa membenahi Curve-nya(lengkungan) dengan Shape tool 

 

8. Lalu seleksi semua huruf dan Weld-kan (Satukan dengan Weld Tool) tinggal kita permanis 

dengan tambahan-tambahan yang kita mau, seperti menambahkan Contour ( Effect > 

Contour) pada tulisan tadi seperti dibawah ini, kita andalkan imajinasi kita sendiri ya... 

 
 

Dibawah ini juga, tapi keliatan g ya???? 



 
Kalau g kliatan neh dikasih versi vector biasa 

 

 

 

 

LATIHAN III 

Modifikasi huruf dengan efek 3 Dimensi 

Kita juga dapat melakukan modifikasi huruf dengan efek 3 dimensi dengan berbagai cara 

yaitu diantaranya dengan menggunakan fitur perspektif atau dengan menggunakan fitur yang 

ada pada bitmap. 

Contoh modifkasi dengan menggunakan fitur perspektif : 



1. Langkah awal kita buka program corel draw dan buat file baru ( langkah ini tentunya 

temen-temen dah paham jadi gak perlu dijelasin lagi) 

2. Pilih font tool dalam toolbar untuk membuat teks. Klik sekali pada lembar kerja dengan 

maksud untuk menghasilkan teks dengan format artistic dan ketik WORKING 

 

 
 

3. Lakukan break part terhadap teks yang sudah ditulis agar terpisah dan dapat di edit satu 

persatu dengan mengklik object, klik break apart atau Ctrl + K 

 

4. Langkah selanjutnya klik extrude pada tool bar lakukan setting warna pada extrusion color 

 

 

 

5. Lakukan pada huruf berikutnya dengan cara yang sama setelah itu lakukan add perspektif 

  



Lakukan terus untuk teks berikutnya 

 

 

 

 

LATIHAN IV 

Sessi 3 

EFEK CLIP 

Kali ini kita akan coba membuat suatu efek tulisan dengan Coreldraw dengan nama efek 

clip…. 

Berikut langkah – langkah nya : 

 

1. buat background kotak misalnya abu-abu. 

 

2. buat tect ‘CLIP’ dengan font arial black  

 

Mulai bekerja : 

 

1. buat kurva tertutup, dengan pen tool, lalu isi warna atau fill dengan hitam 

 

http://www.ilmugrafis.com/


 
 

2. kurva tertutup di beri warna gradiasi hitam ke putih dengan tool interactive fill tool. Drag 

seperti pada gambar berikut 

 
 

 

 

 

 

 

3. rencananya kita akan menggunakan  POWER CLIP  untuk memasukan kurva kedalam text 

‘CLIP’ 

 



 
 

6. Dengan cara seperti sebelumnya anda tentu bisa membuat gradiasi hitam putih Untuk text 

’CLIP’  sehingga tampil sebagai berikut. 

 

 
 

7. Agar lebih terasa perbedaannya dengan background, buat outline putih pada text‘CLIP’ 

sebagai berikut 

 



 

 
 

“ EFFECT CLIP ” 

 

 

LATIHAN V 

MEMBUAT PETA EFFECT 3D 

Nah setelah effect kita akan pelajari bagaimana cara membuat text effect 3D.  

MEMBUAT PETA 3D 

Dalam Kartu undangan, peta merupakan bagian yang tidak terpisahkan. Terkadang perusahaan 
percetakan menawarkannya dalam sebuah paket ,termasuk didalamnya kartu undangan, kartu 
ucapan terima kasih, peta lokasi, plastik, cindera mata, buku tamu, dll. 
 
Pada modul kali ini, akan dibuat peta 3 D, tool-tool yang digunakan antara lain pen tool, text tool, 
Rectangle tool,  sedangkan fasilitas yang digunakan ialah weld dan add perspective. 
 
 
LAngkah - Langkahnya:  
1. Langkah pertama yang harus selalu dilakukan sebelum membuat gambar adalah menetapkan 
areal gambar, di sini dibuat dalam ukuran 90 x 145 mm, buat kotak sebagai guideline. 
 
 
2. Pilih pen tool, buat alur jalan dengan cara klik pertama untuk menentukan titik awal dan geser 
mouse ke arah yang diinginkan lalu klik untuk menentukan titik akhir, dimana antara titik 
pertama dan ke dua ada garis yang menghubungkannya. Untuk membuat jalan lengkung : 
klik  geser mouse klik tahan dan geser mouse untuk membuat lengkung 

http://www.ilmugrafis.com/coreldraw_free.php?page=corel-membuat-peta-3-dimensi
http://www.ilmugrafis.com/guestbook.php
http://www.ilmugrafis.com/coreldraw_free.php?page=corel-membuat-peta-3-dimensi


 
 
 
3. Jika sudah selesai, pilih Edit > Select All (Ctr A) tekan F12 untuk mengatur property garis, beri 
ketebalan garis = 4 pt. Selanjutnya pilih menu Arrange > Convert to objek (shift+Ctrl Q) untuk 
membuat garis menjadi kurva. Atur warna pada Color Pallet garis = hitam, fill = kuning. 
 

 
 
 
4. Selanjutnya bentuk objek tadi menjadi 3 D, caranya aktifkan objek, pilih menu Effects > Add 
Perspective 
 
 
5. Pilih ujung handle, sehingga kursor akan berubah menjadi tanda (+), klik – tahan – tarik 
handle untuk membuat perspektif. Hentikan jika kita sudah mendapatkan bentuk yang kita 
inginkan. 

 
 
6. Buat text untuk menamai jalan, simpan di tempat yang diinginkan. 

 
 
 
8. Untuk membuat gambar gedung, gunakan Rectangle tool, buat objek segiempat, beri warna, 
ubahlah segiempat tadi menjadi 3D, klik Interactive Extrude, klik gambar tahan dan tarik 
garisnya sehingga membentuk objek 3D, Untuk Lebih jelasnya hal ini juga berhubungan dengan 
(baca: Mudahnya Tulisan 3d dengan Coreldraw ) , sesuaikan dengan perspektif yang kita buat. 
 
 
 
9. Selain bentuk segiempat, bisa pula bentuk segitiga, polygon atau gambar rumah. 

http://www.ilmugrafis.com/coreldraw_dasar.php?page=tulisan-3d-coreldraw


Hasilnya kira - kira seperti ini: 

 

 

LATIHAN VI 

SESSI 4 

 

 

INVISIBLE TEKS WITH DROP SHADOW 

LANGKAH - LANGKAHNYA:  
 
 
1. First step yang pasti buka Corel, lalu Ctrl+N buat new blank page... 
2. Ok pasti semua udah pada bisa impor image kan?  

3. Langkah berikutnya kita buat text sesuka hati deh!! misalnya “Demonation” seperti gambar 
dibawah ini, warnai putih agar terlihat jelas(sebenarnya gak ngaruh banyak :D ) 

 
 
4. Copy image beserta text diatas tadi menjadi dua seperti gambar dibawah ini 

http://www.ilmugrafis.com/


 
 
5. Lalu transparankan text yang berada pada image kanan dengan mengklik color box paling atas 
diatas warna hitam (saya yakin anda semua sudah tau..hehe..) lalu klik kanan pada warna merah 
dan text tersebut akan terlihat outline-nya saja seperti berikut 
Hasil sementara: 

 
 
6. Setelah itu group-kan(Ctrl+G) image dan text (sebelah kanan) tersebut 
 
7. Seleksi image kanan tadi lalu klik Effect > Power Clip > Place Inside Container...  
 
8. Lalu klik-kan tanda panah besar itu pada text bagian kiri dan alu terciptalah gambar seperti 



dibawah ini (halah...) 

 
 
9. Setelah itu tekan tombol Ctrl pada keyboard kalian dan klik tex tersebut, maka contents 
didalamnya akan terlihat 
 
10. Nhah... Disana akan terlihat contents yang kita masukan tadi, tinggal kita mengepaskan text 
pada gambar tersebut dengan text yang berada diluar seperti pada gambar dibawah ini.(Terlihat 
gak ya?...) 



 
 
11. Setelah kira-kira pas, Ungroup-kan(Ctrl+U) image tersebut dan Del textnya, lalu tekan 
tombol Ctrl lagi dan klik diluar object maka kalian akan berada diluar contents tadi, dan kalian 
akan melihat image menjadi seperti gambar dibawah ini 

 
 
12. Selanjutnya, seleksi text tersebut lalu klik kanan pada warna transparan di color box, dan 
text itu seperti tidak kelihatan, sekarang tinggal menambah Drop Shadow-nya 
 
13. Seleksi text tersebut lalu klik pada tool bar Blend Tool > Drop Shadow 



 
 
14. Lalu di atas akan muncul Property Bar : Interactive Drop Shadow lalu di submenu yang 
bertuliskan preset... Gantilah dengan Small Glow 

 
 
Seperti gambar diatas, setelah itu ubahlah Opacity-nya menjadi 100 dan Feathering-nya 10 dan 
lalu ubah Feathering Direction-nya menjadi Outside seperti gambar dibawah ini 
 



 
Setelah itu text akan terlihat jelas... 
 
15. Nhah agar menjadi lebih keren Ubah Transparency Operation-nya dari Normal menjadi 
Add seperti gambar dibawah ini 



 
 
Udah deh... 
 
17. Langsung saja Export (Ctrl+E) jadi JPG bitmap, urusan Export mengexport kalau ada yang 
belum tau dapat ditanyakan kepada Administrator atau penulis lain atau saya sendiri (hehehe...) 
 
Hasilnya:  

 

 

 



LATIHAN VII 

SESSI IV 

 

saya mencoba untuk memberikan sedikit pengetahuan tentang penggunaan Mesh Fill Tool 
dan Interactive Blend Tool dengan menggunakan proses pembuatan gambar Apel 
sebagai buah percobaan… 
 
Here we go…  
 
1. Tentunya Corel telah terbuka dan new document telah terbuat, lalu buatlah objek seperti 
gambar di bawah ini. 

 
Warnai dengan Interactive Fill Tool, merah dan merah hati, kalaupun mau warna hijau ya 
warnailah hijau muda dan hijau tua, karena di sini saya menggunakan warna merah jadi saya 
akan terus menggunakan warna merah ini. 
 
2. Ok, setidaknya kita sudah memiliki APEL yang lumayanlah, kemudian buatlah object seperti di 
bawah ini :  



V 
Untuk memberikan kesan bahwa itu melengkung, hahaha… Lalu warnai objek tersebut dengan 
menggunakan merah muda sekali, clik dan tahan pada Color Palette warna maka akan keluar 
New Pallete Windows seperti gambar di bawah ini. 
 

 
Pilih yang paling muda. Kemudian dengan menggunakan Interactive Tranperancy Tool, 
transparansikan bagian atas objec tadi seperti pada gambar di bawah ini. 



 
 
 
3. Setelah langkah di atas, copy objec apel kemudian warnai merah tua banget atau agar lebih 
mudah, warnai saja hitam. 

 
Kemudian klik Interactive Transperancy Tool, ubah Transperancy Type ke Radial  
 
 
Kemudian klik pada Icon Edit Transperancy yang berada di sebelah kiri Transperancy Type tadi, 



setelah di klik tentunya akan muncul jendela baru seperti gambar di bawah ini 

 
Kemudian klik pada Icon Edit Transperancy yang berada di sebelah kiri Transperancy Type tadi, 
setelah di klik tentunya akan muncul jendela baru seperti gambar di bawah ini : 

 
Pilih Custom seperti yang saya lingkari merah pada gambar di atas, lalu klik dua kali pada 
Fountain preview untuk membuat node seperti yang saya lingkari biru pada gambar di atas, lalu 
kembali ke objek, ubah posisi Transperancynya seperti pada gambar di bawah ini 
 



 
Kemudian centerkan pada objek apel sebelumnya. 

 
 
4. Selesai? Belum ladies and gentleman…. Masih terlalu jauh untuk berhenti… Sekarang buatlah 
dua objek oval seperti pada gambar di bawah ini. 

 



Besar kecil seperti gambar di atas, letakkan sama persis seperti gambar di atas, warnai oval 
besar dengan warna yang sama dengan warna apel, merah. Warnai objek oval kecil dengan 
merah tua, setua-tuanya. Lalu klik Interactive Blend Tool 
 

 
Kemuadian klik Objek Oval Kecil lalu tarik sampai snap ke objek oval besar, jika benar, maka 
jadinya akan seperti gambar di bawah ini. 

 
Lalu letakkan objek yang telah kita blend ini di atas apel, seperti pada gambar di bawah ini. 

 
 
5. Kemudian kita akan membuat rantingnya. Buatlah objek seperti gambar di bawah ini. 



 
Dengan menggunakan Bezier Tool atau FreeHand Tool, tergantung kebiasaan saja. Lalu warnai 
Merah Tua seperti warna Objek Oval Kecil tadi sehingga terlihat seperti tidak berpotongan atau 
menyatu. 
 

 
Seleksi objek tersebut lalu klik Mesh Fill Tool 

 
Maka akan terjadi perubahan pada objek tersebut seperti pada gambar di bawah ini. 



 
 
Lalu seleksi node-node yang berada di kiri objek, lalu berilah warna lebih sedikit terang. 

 
 
6. Okeee… Sebenarnya sudah jadi APEL seperti ini.  



 
Jika ingin menambahkan daun, bisa membuat daun lalu gunakan Mesh Fill Tool untuk 
mewarnainya 
 
 

 
Demikian proses pembuatan Apple 

 

http://www.ilmugrafis.com/coreldraw_free.php?page=membuat-apel-apple


 

LATIHAN VIII 

Sessi v 

MEMBUAT KARTU NAMA 

 

Kali ini penulis ingin berbagi tips untuk membuat desain kartu nama simpel tapi mempunya 
nilai tinggi…*_- 
buat dengan nama masing masing 
 
 
Menarik bukan? Begini Langkah-langkahnya: 
 
1. BukaCoreldraw - New - Buatlah kotak menggunakan Rectangle Tool dengan ukuran 9 x 5,5 
cm (salah satu ukuran standart kartu nama) 
 
KOTAK DENGAN UKURAN 9 CM X 5,5 CM  
 
2. Klik pada objek kotak menggunakan Pen Tool kemudian perhatikan properti bar diatas,Pada 
propertis Corner Roundness ganti 0 menjadi 5 yang bertujuan agar sisi pojok pada kotak agar 
lebih melengkung… 

 
PROPERTIES PEN TOOL 
 
3. Klik Fill Tool - Pilih Fountain Fill Dialog (menberikan warna gradient pada objek) 

 
Setelah itu Muncul Panel seperti berikut: 

http://www.ilmugrafis.com/coreldraw_free.php?page=desain-kartu-nama-simple


 
PENGATURAN FOUNTAIN FILL 
 
Ganti beberapa propertis yang diberi tanda diatas :  
- Type : Gradient  
- Angle : -90  
- From : Blue  
- To : Cyan  
- Tekan tombol OK  
 
4. Butlah persegi panjang (kotak dengan garis kuning) dengan menggunakan BEZIER TOOL, 

Sehingga membentuk objek seperti gambar dibawah ini: 

 
 

5. Klil Pada SHAPE TOOL kemudian Blok Objek (1) > KLIK KANAN – TO CURVE (agar 
garis tersebut dapat dilengkungkan) 



 
 
6. Tarik Garis Lurus tersebut hingga melengkung sesuai dengan keinginan anda 

 
Beri warna pada objek tersebut sesuai keingginan anda kemudian... 
 
7. Pilih INTERACTIVE TRANSPARENCY TOOL untuk memberikan efek transparan pada objek 
(1) 
 
 
8. Klik pada Objek 1 kemudian Tarik Garis hingga membentuk transparansi objek seperti 
dibawah ini: 

 
 
9. Kemudian buat 2 garis Lurus menggunakan BEZIER TOOL seperti gambar dibawah dan ulang 
efek seperti langkah di atas.. 



 
 
10. Terakhir tambahkan Teks sesuai dengan apa yang ingin anda isikan dalam kartu nama 
tersebut..hingga menjadi kartu nama yang simpel tp bermutu.. 
 
Ini adalah salah satu contoh, namun Anda bisa berimprovisasi sendiri: 
 
 

kali ini kita akan membuat tulisan dengan efek Artistik media, sama halnya dengan brush pada 
photoshop maka di Coreldraw kita bisa menggunakan fitur ini untuk menciptakan efek artistik. 
Ok mari kita berlatih membuat teks dengan efek artistik media 
 
Langkah - langkahnya: 
1. Buka Coreldraw, buat dokumen baru (ctrl + N) 
 
2. Gunakan Teks Tool (Shortcut Tombol F8), Tulis teks yang akan diberi efek , contoh:  

 
Disini Tulisan menggunakan font Arial Black, anda bisa mencoba type font yang lain kalau mau 
 
 
3. Convert tulisan tersebut ke Curve, caranya klik Arrange >> Convert to Curves 

http://www.ilmugrafis.com/photoshop_dasar.php?page=pemasangan-penggunaan-brush-photoshop-lengkap
http://www.ilmugrafis.com/photoshop_dasar.php?page=pemasangan-penggunaan-brush-photoshop-lengkap
http://www.ilmugrafis.com/coreldraw_free.php?page=teks-efek-artistik-media-coreldraw


 
 
 
4. Klik artistik media (shortcut Tombol i) 

 
 
 
5. isikan Stroke land, berapa saja tp disini saya menggunakan 0.7, jika terlalu besar bisa 
diturunkan ke 0.1 atau ke 0.2 karena ini sangat berpengaruh pada hasil akhirnya  

 
 
 
6.  Selanjutnya akan muncul DOCKER Artistic Media 



Jika DOCKER tidak muncul , pada menu utama klik Arrange >> Artistik Media 
Pilih salah satu bentuk Artistik media pada daftar dengan cara klik kiri pada bentuk yang 
diinginkan.  

 
Ok selesai, hasilnya: 

 
Artistik media ilmugrafis 

http://www.ilmugrafis.com/coreldraw_free.php?page=teks-efek-artistik-media-coreldraw


 

LATIHAN IX 

Sessi VI 

 

typography sederhana pada wajah atau bentuk lain. Anda tidak harus menggunakan Photo 
Chairil Anwar, karena bisa diaplikasikan kesemua image, tapi disini saya namakan dengan nama 
beliau dan karena memang menggunakan potret diri sang pujangga idola saya ini, Chairil Anwar. 
 
Langkah-langkahnya : 
 
 
1. Buka corelDRAW lalu buat dokumen baru 
 
 
2. Import image yang akan digunakan, disini seperti yang saya katakan tadi, saya menggunakan 
image dibawah ini 

http://www.ilmugrafis.com/coreldraw_free.php?page=typography-chairil-anwar
http://www.ilmugrafis.pw/coreldraw/c_drawing_14/coreldraw_free_14_clip_image002.jpg


 
Image diatas bukan lagi image asli yang saya dapatkan di google, tapi sudah melalui tahap edit 
melalui photoshop, karena image dari google resolusinya sangat kecil, sebenarnya tidak masalah 
jika imagenya sudah dengan resolusi yang sedikit besar, tidak perlu menggunakan photoshop, 
langsung saja import ke corel, usahakan image sudah hitam putih seperti diatas, nanti saya buat 
lagi modul  membuat hitam putih seperti diatas. 
 
 
3. Kemudian Klik Bitmaps >> Convert to Bitmaps, maka akan muncul windows seperti dibawah 
ini 



 
Color mode ubah menjadi Black and White (1 Bit), lalu klik OK. 
 
 
4. Kemudian Klik kanan pada image tadi, lalu pilih Trace Bitmap >> Line Art... 

 
Maka akan muncul Windows seperti dibawah ini 



 
Perhatikan yang saya tandai biru diatas, Pada Trace Control, sesuaikan dengan kehendak anda, 
pada kolom Color, ubah color modenya menjadi Black and White, Pada kolom Option, cek 
remove background. Lalu klik OK. 
 
 
5. Pindahkan image traced

 
Kemudian Ungroup image Traced(hasil Trace) lalu warnai dengan warna apa saja, satu-satu agar 



nanti kita bisa me-Weldkan mana yang seharusnya di Weld dan mana yang tidak. 

 
Saya warnai biru muda disini, lalu Klik Bagian lain yang belum terwarnai bitu atau masih 
berwarna hitam, kemudian tekan Shift Tahan dan klik yang berwarna biru, lalu klik Weld 

 

 
Jika benar maka warna hitam tadi akan berubah menjadi biru seperti warna biru yang saya 
pakai tadi 



 
Lakukan hal yang sama pada setiap bagian yang masih hitam, yang besar-besar saja, yang 
bercak-bercak tidak perlu. Jadinya akan seperti image dibawah ini 

 
 
 
6. Setelah itu, kita benahi image ini agar tepiannya halus, kita gunakan Shape Tool (F10) 



 
Benahi curve-curve yang dirasa tidak bagus, delete lalu benahi, kita Skip saja detil dari langkah 
ini(hehe), jadinya akan seperti ini 

 
Sedikit lebih halus(haha). 
 
 



7. Duplicate / Copy menjadi dua image tersebut, kemudian kita tutup bagian putih pada image 
copy, dengan menggunakan Bezier Tool, seperti gambar dibawah ini 

 
Perhatikan Garis Hitam, berada dalam object berwarna biru, karena memang harus 
bersinggungan, kemudian klik object yang kita buat dengan bezier tool ini kemudian tekan Shift 
tahan dan Klik di object berwarna biru, lalu Weld-kan, maka akan jadi seperti gambar dibawah 
ini. 

 



Yang saya warnai merah yang kita buat tadi. 
 
 
8. Baik, kita mulai Typing sekarang. Klik Text tool, lalu arahkan pointer pada tepian gambar 
berwarna merah, sampai ada Information dengan tulisan "Edge" kemudian klik. 

 
Perhatikan Edge kecil diatas(susah saya jelasinnya, semoga anda mengerti) lalu akan ada Outline 
putus-putus di dalam image berwarna merah seperti gambar dibawah ini 

 
Jika sudah ada garis putus-putus dan tulisan "Click here whit Text Tool to add Paragraph Text" 
Maka anda sudah bisa menuliskan sesuatu didalamnya, pertama Klik dulu Text Tool lalu klik 
dalam image tersebut diatas, tuliskan apa saja, disini saya memakai puisi dari Chairil Anwar 



"Aku". 

 
Saya menggunakan Size 8pt Font Arial dan Alignment Force Justify. 

 
 



 

 

LATIHAN X 

Sessi VII 

 

membuat desain undangan 

 

Pertama-tama kita membuat kotak merah 

 
 

Lalu dari kotak itu tekan CTRL+C lalu dilanjutkan CTRL+V yang dimaksudkan mengkopi 

bangun itu di tempat yang sama. Warnai kotak kedua dengan warna kuning. 



 

 

Selanjutnya tekan CTRL+Q untuk mengubah objek kotak itu menjadi vector. 

Tekan F10 untuk shape tool. Bengkokkan tengah garis ke bawah. 

 

 
 

Lalu tekan F11 dan akan muncul panel Fountain Fill 



 
 

Kolom type linear diganti dengan conical dan pilih custom 

 
 

Mulanya, kolom bagian pewarnaan ada 2 saja antara putih dan hitam. Tapi langsung klik 2X 

pada segitiga di bagian  pewarnaan untuk menambah pewarnaan. Terus pada kotak siluet itu 

pada mulanya di tengah, seret sendiri ke kanan bawah seperti gambar diatas.  

Hasil akan tampak seperti dibawah : 



 
 

Lalu samarkan dengan transparancy tool 

 
 

Hasil tampak seperti dibawah : 

 
 

Lalu buat bangun bintang dengan menu complex star tool 



 
 

Lalu tarik complek star itu ke kanan dengan menu interaktiv distortion tool 

 
 

Dan warnai hitam untuk sementara. Copy menjadi 4 yang bersinggungan dan kasih efek 

transparan dengan interaktive transparancy tool dari kanan ke kiri. Seperti pada gambar 

dibawah : 



 
 

Lalu masukkan ke kotak merah yang tadi dengan menu effect => power clip => place inside 

container 

 
 

Hasil akan tampak seperti gambar bawah : 

 



 

Klik kanan pada gambar lalu edit content 

 
 

Tarik ke kanan atas dan warnai putih. Setelah itu klik kanan lagi, pilih finish edit. 

Dan kalau digabungkan dengan pembuatan garis pelangi yang tadi akan tampak seperti 

dibawah :  

 

 
 

Perlu diingat, bangun lengkung pelangi harus berada diatas kotak yang telah diisi dengan 

motif bunga. 

 

 

 

Nah, dari sini kasih background sinar pada gambar pengantin itu dengan tool interactive drop 

shadow tool. Lihat gambar bawah 

 

 
 



Tinggal kasih tulisan dech…. 

 

 

LATIHAN VIII 

 

Rahasia Di Balik Pembuatan Banner Website Bertema Rainbow City 

Tidak selalu membuat desain itu dimulai dari nol, atau dari dasar tanpa bantuan image yang 

telah jadi. Dalam  modul Coreldraw kali ini saya akan mencoba mengkolaborasikan antara 

image dan vector dalam corel untuk membuat sebuah banner website 

 

1. Buka Coreldraw, kemudian saya masukkan image (gambar) yang akan kita edit dulu ke 

Corel. 

Caranya : File > Import > Pilih File Image > Import, Seperti dibawah : 

http://www.ilmugrafis.com/coreldraw_free.php?page=create-banner-website-dengan-corel
http://www.ilmugrafis.com/coreldraw_free.php


 
Gambar : Hongkong Night City 

 

2. Lalu saya potong sebagian bagian bawahnya, caranya dengan Crop Tool pilih bagian yang 

akan disisakan dan hasilnya menjadi seperti di bawah ini : 

 
gambar : Hasil Cropping  

 

3. Jangan lupa untuk member efek contrast pada gambar dengan cara Bitmap > Image 

Adjusment Lab. Maka akan muncul menu seperti di bawah : 



 
gambar : Pengaturan Contrast 

 

Geser contrast ke kanan ke point 50. Maka akan Nampak image semakin jelas. 

 

4. Lalu selanjutnya, duplikat ukuran image dengan segi empat, lalu saya buat efek rainbow 

didalam segi empat tersebut  dengan Effect > Power Clip > Place Insiede Container. ( Ingat, 

jangan diberi hairline karena bila diberi maka akan terlihat garis hitam antar warnanya. )  

 

Berikan Efek Transparasi dengan Transparency Tool dengan pengaturan Linear / Normal 

diberikan dari atas ke bawah dan menggeser ponter tengah agak kebawah. 



 
gambar : pengaturan tranparency 

 

5. Lalu saya beri efek random rainbow. Caranya duplikat rainbow lalu Klik sisi kanan bangun 

rainbow yang terduplicat, dengan disertai shift , drag ke kiri sehingga rainbow membalik tapi 

dengan ukuran yang diperkecil. Supaya lebih jelasnya, kalau saya pisahkan akan menjadi 

seperti ini 

 
gambar : efek rainbow  

 



Tumpuk gambar Hongkong City dan Rainbow mejadi satu, lalu klik Finish Editing This 

Level untuk mengakhiri Power Clip. Maka akan seperti ini hasilnya 

 
gambar : Rainbow City  

 

6. Beri tulisan sederhana tentang judul gambar atau sesuatu yang akan dipromosikan. Lalu 

masukkan tulisan itu dengan effect powerclip kedalam kotak rainbow tersebut 

 
gambar : tulisan judul 

 

LATIHAN X 

 

Kali ini saya akan berbagi modul yang berkenaan dengan proses bitmap dan effectnya. 

1. Pertama buka corel draw X7, lalu new sheet. 

  

2. Masukkan gambar original beresolusi tinggi dari city dimension, hasilnya seperti dibawah : 



 
gambar : city dimension 

  

3. Lalu klik gambar tersebut BITMAPS > CONVERT TO BITMAP > PILIH RGB > RESOLUSI 300.  

 
gambar : menu convert to  

 
gambar : rgb 300 dpi  



Saya memilih RGB didasarkan pada ukuran file yang lumayan kecil ketimbang CMYK. 

  

4. Copy / gandakan menjadi 4 gambar yang sama (tinggal di copy dan paste saja).  

 
gambar : gandakan jadi 4  

Lalu klik pada gambar 1 > klik Transparent tool > 



 
gambar : transparency tool  

drag dari kiri ke kanan gambar 1, 

 
gambar : part 1 

setelah itu klik BITMAPS > CONVERT TO BITMAP > PILIH RGB > RESOLUSI 300 , jangan lupa 

centang transparent background, supaya background menjadi transparan 

Ulangi lagi langkah transparancy nya dari bawah ke atas, lihat gambar : 



 
gambar : transparency ke bawah 

setelah itu klik BITMAPS > CONVERT TO BITMAP > PILIH RGB > RESOLUSI 300 lagi, sehingga 

hanya menyisakan gambar 1 pada samping kiri atas saja, 

Kemudian berikan efek hijau dengan klik BITMAP > IMAGE ADJUSTMENT LAB > TINT 

 
gambar : image adjustment lab 



untuk gambar ke 2 sisakan di bagian kanan atas lalu warnai (masuk ke IMAGE ADJUSTMENT 

LAB > berikan warna oranye , main di temperature dan tint),  

untuk gambar ke 3 sisakan bagian separuh atas lalu warnai juga (masuk ke IMAGE ADJUSTMEN 

LAB > berikan warna biru, main di temperature dan tint juga),  

sedangkan untuk gambar ke 4 jadikan mode black and white (hitam putih), caranya klik gambar 

ke-4 lalu masuk ke BITMAPS > IMAGE ADJUSTMENT LAB > setting seperti ini : 

 

gambar : no 4  

Hasil jadi akan terlihat seperti di bawah : 



 
gambar : 4 bagian  

  

5. selanjutnya bisa ditumpuk menjadi 1 kesatuan dengan yang lain, sehingga hasilnya seperti ini : 

 
gambar : third dimension  

6. Beri tulisan Third Town Dimensions, lalu BREAK TEXT APART dengan menekan (ctrl + K) 

agar teks yang kita ketik terpisah. 



7. Beri warna disetiap kata yang sewarna dengan langit gambar tersebut, copy tapi balik tulisan 

tersebut dari atas ke bawah yang bermaksud untuk menciptakan efek bayangan. Klik tulisan yang 

terbalik di bawah lalu transparansi dari bawah ke atas. Untuk memberikan efek blur pada tulisan 

Third, CONVERT TO BITMAP > BLUR > GAUSSIAN BLUR, beri radius 5.0 pixel.  

 SESSI VIII 

 

UJIAN / TEST 


